Ans.

AnS.

AnS.

Ans.

AnS.

Ans.

AnS.

AnS.

AnS.

Ans.

AnS.

AnSs.

Chapter-8 : Exploring More Features of Adobe Photoshop
Practice Zone [Pg. no. 141]

Which Photoshop tool will you use to:

Duplicate a part of an image by setting the sampling point in the image?
Clone Stamp Tool

Quickly remove blemishes and other marks in photos without setting the sampling point?
Spot Healing Brush Tool

Remove all areas that share similar pixels in an image?

Magic Eraser Tool

Darken certain areas of an image?

Burn Tool

Give an effect of spreading paint across the image?

Smudge Tool

Moderate or soften the focus of some areas of an image?

Blur Tool

Practice Zone [Pg. no. 145]

State whether the following statements are True or False.

Layers let youwork on an individual part of an image without affecting others.

True

You cannot change the stacking order of layers.

False

When you insert text in Photoshop, it is created on a separate layer called the Type Layer.
True

Elements placed on higher layers are displayed below the elements placed on lower layers.
False

You cannot apply effectson layers.

False

An image can have only one background.

True

Assessment Zone [pg.149]

Choose the correct answer.

Which of the following tools lets you erase all that share similar coloured pixels?
a. Magic Eraser Tool b. Background Eraser Tool

c. Type Tool d. Clone Stamp Tool



Ans.

Which of the following tools can be used to repair imperfections such as scratches, blemishes
and marks in an image?

a. Blur Tool b.Burn Tool
c. Sharpen Tool d. Healing Brush Tool

Which of the statements holds true for filters?

a. Filters let you changes the appearance of an image by adding special effects to it.
b. You can apply a filter to an entire layer, or a selected portion of a layer.

c. You can apply multiple filters to an image using the Filter gallery.

d. All of the above

What is the use of Type Tool?
a. It is used for inserting text in Photoshop.
b. It is used for filling an area with a selected pattern in Photoshop.
c. Itis usedto lighten areas of an image in Photoshop.
d. It is used for erasing the background colour of animage in Photoshop.

Which of the following tools will you used to create an effect of spreading the paint across the
image as if you have dragged your finger through wet paint?

=
N o )
C. ﬂ d. None of these

Fill in the blanks using the words given in the box.

The Backaround Eraser tool allows you to erase the background colour from an image or a
layer.

Lavers lets you work on individual parts of an image without affecting others.

The Clone Stamp tool lets you duplicate part of an image by settinga sampling point in the image.
You can use the filter gallery to apply multiple filters on the image or individual filters more

than once onan image.
To reduce focus on selected portions of an image, you use the Blur tool.

The layer at the bottom of the Layer panel is called Background.

Answer the following questions.

How is Healing Brush Tool different from the Spot Healing Brush Tool?

The Healing Brush Tool allows you to repair imperfections such as scratches, blemishes and
marks in an image. The Spot Healing Brush Tool works in a similar manner to the Healing Brush
Tool exceptthat it does not require the sampling point to be set. It automatically picks up the
sampled pixels from around the area to be retouched.



AnS.

Ans.

Ans.

AnS.

Ans.

AnS.

AnS.

What is the purpose of the Clone Stamp tool?

The Clone Stamp Tool lets you duplicate the parts of an image by setting a sampling point inthe image to
be cloned.

Name the three variants of the Eraser Tool.

The three variants of the Eraser Tool are:

(1) Eraser Tool, (2) Background Eraser Tool, (3) Magic Eraser Tool

e The Eraser Tool erases pixels as you drag it across an image.

e The Background Eraser Tool allows you to erase the background colour from an image or
a layer.

e The Magic Eraser Tool erases all areas that share similar coloured pixels.

What is the use of layers in Photoshop?

e Layers can be thought of as transparent sheets mounted on the top of each other.
e Layers let youwork on an individual part or an element of an image without affecting the
other parts or elements.

What is the use of filters?

Filters let you change the appearance of an image by adding special effects to it.

How is the Dodge Tool different from the Burn Tool?
The Dodge tool is used for lightening the areas of an image.
The Burn tool is used for darkening the areas of an image.

What do you understand by warping text in Photoshop?

Warping text means to change the shape of the text in a number of interesting ways such as that
of a wave, a flag or an arc.

How will you add effects to the contents of a layer?

The steps to apply the layer effects are:

1. Select a Layer in the Layers panel.

2. Click the Layer Styles button at the bottom of the Layers panel and choose an effect

from the list or Choose Layer =>Layer Style.

3. The Layer Style dialog box appears. Choose the desired effect by clicking the
corresponding check boxes on the left side of the dialog box.
Set appropriate options for the selected effect on the right side of the dialog box.
Click OK to apply the effect.
6. When you apply layer effects, an ‘fx’ icon appears to the right of the layer name in
the Layers panel.

ok



Chapter-7 : Introduction to Adobe Photoshop CC 2015
Practice Zone [Pg. no. 121]

Which tool will you use to:

1. Select areas of an image which share a similar color?
Ans. Magic Wand Tool

2. Select objects by sticking the selection border to the edges of an object?
Ans. Magnetic Lasso Tool

3. Remove portions of an image which are not required?
Ans.  Crop Tool

4, Drag a selected part of an image to a new location?
Ans. Move Tool

5. Make a selection in an elliptical or a circular shape?
Ans. Elliptical Marquee Tool

6.  Select a portion of the image by drawing a freehand area?
Ans. Lasso Tool

Assessment Zone [pg. no.128-129]

A. Choose the correct answer:

1. Which one of the following tools lets you fill selected areas of an image with a blend of multiple

colours?
a. Custom Shape Tool b. Gradient Tool
c. Color Replacement Tool d. Magic Wand Tool
2 Which of the following tools can be used for making selections around the edges of an image?
a. Rectangular Marquee Tool b. Move Tool
c. Magnetic Lasso Tool d. Crop Tool

3. Magic Want tool is an example of___category of tools.
a. Selection b. Drawing

c. Painting d. Color Picker

4. Which one of the following statements holds true for the Color Replacement Tool?

It can be used to replace a selected colour with the foreground colour.
b. It can be used to replace a selected colour with the background colour.




AnS.

Ans.
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It can be used for creating soft strokes of colours in your images.
It can be used for moving the selected coloured portion of the image to the new location.

State whether the following statements are True/False:

The Gradient Tool can be used to fill selected areas by blending two or more colours.
True

The Opacity option of the Brush Tool can be used to specify how quickly the paint will be
applied.
False

Using the Magnetic Lasso Tool, you can select only that portions of the image that share similar
colour.
False

When using the Quick Selection tool, the selection expands outward and finds and follows te
defined edges in the image automatically.
True

Fill in the blanks using the words given below:

The Brush tool can be used to create soft strokes of colour in images.

You can create preset shapes such as flowers and grass using the Custom Shape Tool.

To remove the portions of an image that are not required, you can use Crop Tool.

The Magnetic tool allows you to select objects by sticking the selection border to theedges of
an object.

Resolution determines the sharpness and clarity of an images.
You can change the foreground ad the background colours using the Color Picker.

Answer the following questions:

What is the purpose of the following components of Photoshop workspace?
a) Tools Panel b) Options Bar

Tools Panel: The Tools panel offers various tools that let us select, edit, draw, paint and view
images.

Options Bar: The Options bar provides options related to the tool currently selected in the tolls
panel.

For example: To choose the thickness of the Brush Tool selected in the Tools panel, we use the
Options bar

Name the four types of Marquee Tools.

The four types of Marquee tools are:
e Rectangular Marquee Tool

e  Elliptical Marquee Tool

e Single Row Marquee Tool

e Single column Marquee Tool



3.

AnS.

AnS.

Differentiate between the following tools.

a) Polygonal Lasso Tool and Magnetic Lasso Tool

b) Crop Tool and Move Tool

Polygonal Lasso Tool

Magnetic Lasso Tool

The Polygonal Lasso Tool allows us to
makeselections by clicking specific points
around an image.fv

The Magnetic Lasso Tool allows us to
select objects by sticking the selection
border to the edge of an object.

To use this tool, click anywhere on the
image to mark the starting point and then
click at the position where you want the
first straight segment to end.

This tool is particularly useful when there
is a huge contrast between the foreground
objects and the background objects of an
image.

Crop Tool

Move Tool

The Crop Tool is used to discard the
portions of an image that are not required.

The move Tool is used to drag a selected
part of an image to a new location in the
image.

Discuss the following tools.
a) Magic Wand Tool

a) Magic Wand Tool: This tool lets you select those areas of an image which share a similar

colour.

b) Gradient Tool: This tool is used to fill selected areas of an image with a blend of multiple

colours.

c) Custom Shape Tool: A tool that lets you draw a variety of preset shapes such as like flowers

and grids.

b) Gradient Tool

c¢) Custom Shape Tool
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Chapter-6: Introduction to Visual Basic

Practice Zone [pg. no.:97]

State whether the following statements are True or False.

The Property window can display the properties category-wise or in an alphabetic order. True
A method is an action that can be performed on an object. True

Label, TextBox, Button, Form have text property. True

The Visual Basic IDE provides a common environment for designing, editing and removing
errors in the program. True

A Form has no events associated with it. False

The View Code and View Designer buttons are present in the Properties window. False

Practice Zone [pg. no.:103]

Design a VB form which displays the message “Visual Basic is easy to Learn” on a label in
red color when the form is loaded.

Public Class Forml

Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As System.EventArgs)
Handles MyBase.lLoad
1blName.ForeColor = Color.Red
1blName.BackColor = Color.Yellow
1blName.Text = " Visual Basic is easy to Learn"
End Sub
End Class

Assessment Zone [pd. no.106- 107]

Choose the correct answer:
Identify the correct option for Visual Basic.

a. High level programming language b. Based on event driven programming

c. Offers integrated Development d. All of the above
Environment

Which of the following is not a property of Textbox control?

a. Caption b. Text
c. Name d. Enabled

displays a list of various files of a project.

a. Properties window b. Solution Explorer

c. Toolbox d. Menubar
Which of the following best describes a property related to a control?




AnSs.

AnSs.

AnSs.

AnSs.

a. A property is a characteristic such as color and size of an object.

b. A property is an action that can be performed on an object
c. A property can be thought of as an occurrence of any activity related to an object.

d. Label control
The control that is used to display text or instructions on the form.
a. Label control b. Textbox control

c. Button control d. None of these

Fill in the blanks using the words given below:

An IDE provides a common environment for designing, editing, and removing errors in
programs.

A Method is an action that can be performed on an object.

The Solution Explorer window has the View Code and the View Designer buttons.

The Maxlength property of the TextBox control can be used to control the maximum number
of characters that can be entered in the TextBox.

You can use the Designer view to design the interface of the application by placing various
controls on the form.
Write statements in Visual Basic for the following:

Set the title of the form (form name: frmData) to ‘input’

frmData.Text= “input”

Set the contents of a label (label name: 1bIShow) to ‘Display’
IblIShow.Text = “Display”

Disable a textbox (textbox name: txtInterest)

txtInterest.Enabled = false

Answer the following questions.

Why is it easy to write programs using Visual Basic as a language?

e Visual Basic is a high-level programming language that offers a GUI.

¢ Visual Basic offers an Integrated Development Environment (IDE) for writing programs,
hence provides a common environment for designing, editing and removing errors in the
program.

e Visual Basic is also referred to as an event-driven programming language.

Name the different elements that make up the Visual Basic IDE.



Ans.

AnSs.

AnSs.

AnSs.

The different elements of Visual Basic IDE are:
Title bar, Menu bar, Toolbar, Main Window, Form window, Toolbox, Solution Explorer and

Properties window.

Define property, method and event in relation to controls.

1) Property:
e A property refers to the characteristics of an object such as colour and size.
e For example, the BackColor property lets you change the background colour of an
object.
2) Method:
e A method is an action that can be performed on an object.
e For example, the Show method is used to display the form and Hide method is used
to hide the form from displaying.
3) Event:
e An event can be thought of as an occurrence of some user-generated action applied on
anobject.
e For example, Click event is triggered when an object is clicked using a mouse.

Discuss the two ways in which you can add controls on a form.

There are two ways in which you can add controls on the form.
Select the Control in the Toolbox and then drag the control on to the form
OR
Double-click the control in the Toolbox. The control gets added in the top-left corner ofthe
form. Drag it to desired location.

Discuss the various ways to run an application.

To run the application, use any one of the following ways.
1. Press F5

2. Click the Start Debugging —>button on the Toolbar

3. Choose Debug-> Start Debugging



6. How is Label control different from TextBox control?

Ans. Label control TextBox control
1. The Label control 1s used to display text 1. The textbox control 1s used for accepting
on the form. text or numeric values from the user.
2. Some properties of Label control are: 2. Some properties of Textbox control are:
e Name e Name
e BackColor o MaxLength
e BorderStyle e Enabled
e ForeColor * Text
o Text e PasswordChar
3. Some Events of Label control are: 3. Some Events of Textbox control are:
e Click e TextChanged
* DoubleClick e Click
o MouseMove e DoubleClick
7. When do you use Button Control? Name some of its properties.
Ans.

The Button control is similar to push buttons used for initiating some action on the form.
The properties of button control are:

e Name
e [ont
e Enabled

e Text
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CH-3 ADVANCDED FEATURES OF ACCESS 2013

ASSESSMENT ZONE

Practice Zone [Page no.: 52]

Fill in the blanks.
The Query Design option is present on the Create tab.
Data is not visible in Design view of a Form.

The Query results are displayed in the Query Data Sheet view.

The conditions are specified in the criteria /row of the Query Design Grid.

The options on the Design and Format tab let you change the appearance of the form.

Assessment Zone [Page no. 56-57]

Choose the correct answer.

The object to be used to pull out data from one or more tables based on conditions is
a. Query b. Form c. Report d. Table

Which of the following is not a view for working with a Form object?
a. Form View b. Datasheet View c. Design View d. Layout View

The basic elements of a form or report are called
a. Controls b. Objects c. Windows d. Reports

In a Query Design Grid, which of the following options is not present?

a. Criteria b. Sort c. Show d. Filter
A query can be worked on in views, while a report has Views.
a. Two, four b. Three, four c. Three, three d. Four, four

Fill in the blanks using the words given in the box.

Run

When you click on the
Datasheet View.

option on the Design tab, the results of the Query appearin

Queries, forms and reports are Objects of Access.
Form provides a convenient user interface to view, modify and enter data in a databasetable.

Data is not displayed in the Design view of a report or a form.



Ans.

AnSs.

AnSs.

AnSs.

Answer the following questions.

Define the following: a) Query b) Form c) Report

a) Query:- A query is used to retrieve selective data based on specific criteria from oneor more tables.

b) Form:- A form provides an interface that allows user to enter, change and view the datain database
tables.
¢) Report:- Reports are used to present data from tables or queries in a format that canbe printed.

Explain the purpose of the following rows in the Query Design Grid?

a) Sort: - If you want the query results to be sorted, then select Ascending or Descendingorder
from the sort box under that field.

b) Show: - In the Query Design Grid if we clear the Show Check box for any field, thatfield will not
appear in Query result.

¢) Criteria: - If we want to choose or filter the records we can type the search conditionsin the criteria
row of the field.

How can you specify multiple conditions while designing a query?

It can be done in two ways :

(i) Specifying the condition in Criteria row for more than one field will result in a querythat
will select only those records that meet all the conditions.

(ii) Specify the 1 condition in the Criteria row and other conditions in the Qr row, andthe
rows beneath it results in a query that meets one or more of the specified conditions.

What is the use of the Print Preview and the Design View of a report?

» Print Preview: - This view displays the report as it will appear after printing.
» Design View: - Design View displays only the structure of your report.

Differentiate between a form and a report.

Form Report
A form provides an interface thatallows users to | Reports are used to present data from tables or
enter data in a database tables. queries in a formatthat can be printed.
You can work on a form in three \ens You can work on a report in four views.
1. Form view L Re_port_wew
2. Print view

2. Layout view

3. Design view 3. Design view

4. Layout view
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CH-2 INTRODCUTION TO MICROSOFT ACCESS 2013

ASSESSMENT ZONE
Choose the correct answer:
Access is an example of
(a) Word processing software (b) Spreadsheet software
(c) RDBMS (d) Animation software.
Find the odd one out
(a) Date/Time (b) Field Size (c) Required (d) Allow Zero Length
DBMS helps in
(a) reducing data redundancy (b) ensuring data security
(c) enforcing standards. (d) All of these

A field that has a unique value for every record and cannot be left blank is called the
(a) primary key (b) unique key (c) special key (d) none of these

Which of the following field properties lets you specify conditions on the data that can be entered in a
table?

(a) Field size (b) Format (c) Validation Rule  (d) Required
D
is icon for
(a) Primary key (b) Sorting (c) Design view (d) Datasheet view

Which of the following objects in Access lets you retrieve data based on a specific criteria?
(a) Tables (b) Queries (c) Forms (d) Reports

Which property is used to specify a value that gets displayed automatically whenever a new record is

inserted?
(a) Caption (b) Format (c) Validation rule (d) Default value

Fill in the blains using the words given below:

In a relational database, data is stored in the form of tables.
The datasheet view lets you enter data in a table.
You can set the field data types and their properties in the Design view.

The Default value property is used to specify a value that is displayed automatically when the records
are created.

The Primary key field cannot contain duplicate values.

The extension of Access 2013 file is *._accdb

The Eormat property of a field with Date/Time data type determines the manner in which date gets
displayed.



8. Afield with Long Text data type can store more than 255 characters.

C. Atable hasto be created in Access to store details of students. The following table shows a sample
of the data that needs to be stored in the table.

1. Suggest the data types that should be used for each of the fields in the above table
(Field: profile is used to store the profile of the student)

Ans. Sno -Short text
Sname -Short text
Saddress -short text
Sdob - Date/Time
Sprofile - Long Text

2. Suggest a field from the above table, which can be set as the primary key.
Ans. Sno

D. Answer the following questions.

1. Define the following:
1) Table 2) Database 3) DBMS

Ans.

1) Table: They are used to store data in the form of rows (Records) and columns (fields). A Table is
also referred as “relation”.

2) Database: A database is an organized collection of related data so that it can be easily accessed,
managed and updated.

3) DBMS: A database management system is a software program that enables us to create,modify
and extract data from database.

2. What are the advantages of using a DBMS?

Ans. The following are the advantages of using DBMS:
» Reduce data redundancy.
» Reduce update on errors and increase consistency.
» Improve data access to users.
» Improve data security.
» Maintain standards.

3. Distinguish between the following:

a) Record and Fields.
Record Field
» The rows in a table are known as exd » The columns in a table are known as field.

> A record stores complete information about | > A field stores one type of information about
an object or an item. all the object or items.

b) Number and AutoNumber data type.
Number Auto number
The fields with this data type can store numbers. | The field with this data type store integers that
are incremented automatically when a new row




or record is added to a table.

c) Short Text and Long Text.

Short Text

Long Text

» The field with short text data type can store
text or a combination of text and numbers.

> The fields with this data type can have a
maximum of 255 characters.

» The field with this data type can store lengthy
texts and numbers.

» The field with this data type can have a
maximum of 65,536 characters.

d) Validation rule and Validation text.

Validation rule

Validation text

» This property is used to put conditions onthe
data that can be entered in a field.

» You cannot enter a value if it is not according
to the validation rule.

» This property is used to display an error
when the validation rule gets violated.

What is a primary key? How do we set primary key in MS Access?

Ans. A Primary key is a field or combination of fields that uniquely identifies the recordsin a table.

A primary key field cannot have repetitive values and cannot be left blank. To set the primary key
in Ms Access, Place the cursor on the field to be set as the primary key and click on the primary
key option in the Tools group on the Design tab. A key symbol appears next to the field.

What are the two areas of the Design view of a table?

Ans. The two areas of the Design view are:

1. Field Grid Pane: It is used to enter field names and their data types.
2. Field Properties Pane: It is used to set properties for the fields in the table.
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CH-5 TABLES AND HYPERLINKS IN HTML

ASSESSMENT ZONE

Choose the correct answer.

Which of the following is an attribute of the <TD> tag?
(a)Cell spacing (b)Cell padding (c)Border (d)Rowspan

Which of the following is the correct code for creating a hyperlink?

(@ <A name=http://www.google.co.in> Google Home Page </A>
(b) <A url=http: //lwww.google.co.in> Google Home Page </A>
(c) <A href=http: //www.google.co.in> Google Home Page </A>
(d) <A http: //lwww.google.co.in </A>

Which of the following attribute is used to specify the space between the cell wall andthe contents
of the cell?
(a)Cellspacing (b) Colspan (c)Cellpadding (d)Rowspan

Which of the following statements does not hold TRUE with respect to tables in HTML?

(a) The number of pairs <TR> and </TR> determines the number of rows in a table.
(b)The cell spacing attribute specifies the spacing between two adjacent cells of atable.
(c)You can merge the cells using the rowspan and colspan attributes of the <TD>tag.
(d)You can use the bgcolor attribute only with the <TABLE> tag.

Fill in the blanks:

The text enclosed within the TH tag is aligned centrally inside the cell and it is displayed in a
bolder font.

The TR tag is used to add rows to the table.

The tag used for inserting a table heading is caption.

A Hyperlink connects one webpage to another.

Name and Href are the two attributes of <A> tag.

Answer the following questions.

Differentiate between the following.
a)<TR> and <TD> tags

<TR> <TD>
<TR> tag defines a row in the table. <TD> tag defines a cell in the table.

It is the <TR> tag that divides a tableinto rows. | Subsequent rows after the first row in table can
be divided into data cellusing the <TD> tag.

b) Cellspacing and cellpadding attributes of <TABLE> tag


http://www.google.co.in/
http://www.google.co.in/
http://www.google.co.in/
http://www.google.co.in/

Cellspacing

Cellpadding

This attribute specifies the space between two
adjacent cells.

For eg: <TABLE cellspacing = “3” >

This attribute specifies space between the edge
of a cell and the content of the cell.

For eg: <TABLE cellpadding =73">

c) Rowspan and Colspan attributes of <TD> tag

Rowspan

Colspan

This attribute specifies number of rows a
data cell should span.

For eg: <TD rowspan = “27>

This attribute specifies the number of
columns a data cell should span.

For eg: <TD colspan = “2>

d) Internal linking and external linking

Internal linking

External linking

Internal linking involves linking varioussectiong
of the same webpage.

The external linking involves connecting two
different webpage.

It lets the user view the desired section of a
page quickly.

For example: Go to top of the page link in
webpage is an example of Internal linking.

Eg. <A href = “#top” > Go to top of the page
</A>

When you click a Hyperlink, a new
webpage to which the hyperlink is linked
gets displayed in the browserwindow.

Eg. <A href = “second.html” > clickto open
second file </A>

Give the use of Anchor <A> tag.

Ans. The Following are the uses of <A> tag.

(i) Anchor tag is used to create hyperlink in a webpage.
(ii) Any text or image enclosed within the <A> and </A> tag is displayed as a hyperlink.

How is internal linking done on a webpage?
Ans. Internal linking is a two-step process:

(i) Use the name attribute of the <A> tag to give a name to a section to be linked to: For eg.
<a name="xyz”> you will be linked here </a>

(ii) Use the href attribute of the <A> tag to refer to the named section preceded by # symbol.
For eg. <a href = “#xyz” > you will be taken to the linked section </a>.

Explain with the help of an example how to link any text to an email address.

Ans. To link text to an email address, use the ‘mailto’ keyword before the email address in the
href attribute of the <A> tag. For example, To link the text ‘send an Email’ to the email
address maria_joseph@gmail.com, write the following HTML code.
<a href= “mailto: maria_joseph@gmail.com”> send an Email </a>



mailto:maria_joseph@gmail.com
mailto:maria_joseph@gmail.com

Ans,

AnS,

Ans:

Ans.

AnS.
Ans.
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Chapter 4 Images and Lists in HTML

Practice Zone [pg.69]
Find out the errors in the following code segment and write the correct code.

<OL type=a start=c>

<L I>Carbohydrtes

<LI> Minerals

<LI>Protines>

</OL>

Correct codes:-
<OL type="3a” start="3">
<LI>Carbohydrtes
<LI> Minerals
<LI>Protines
</OL>

<UL type=i>

<LI> Delhi

<LI> Mumbai

<LI> Kolkata

</UL>

Correct codes:-
<UL type="disc”>
<LI> Delhi
<LI> Mumbai
<LI> Kolkata
</UL>

<LI type=disc>

<UL> keyboard

<UL> Mouse

</UL>

Correct codes:-
<UL type="disc”>
<LI> keyboard
<LI> Mouse
</UL>

Assessment Zone  [pg.70-71]

Choose the correct answer.

Find the odd one out.
a. Alt b. Src c. Border d. Size
d) Size

Which one of the following values cannot be assigned to the align attribute of the <IMG>
tag?
a. Top b. Right c. Center d. Bottom

c¢) Center
Which of the following cannot be used as the value for the type attribute of the <OL> tag?

Class-VIII



Ans,

Ans.

4.

Ans.

AnS.

AnS.

AnS.

2|Page

a. <OL type=“A">
c. <OL type=“T">

b) <OL type= “one”>

b. <OL type= “one”>
d. <OL type= “a”™>

Each item in the ordered or unordered list is marked using which of the following tags?

a. <OL> b. <UL>

c) <LI>

<LI> d. None of these

Fill in the blanks using the words given below.

You use the type attribute of the <UL> tag to specify the type of bullets to be used in front
of each list item.

The src attribute of <IMG> tag lets you specify the name of the image file to be displayed on
a webpage.

The text to be displayed when an image cannot be shown can be specified using the alt
attribute of the <IMG> tag.

Using the align attribute of the <IMG> tag, you can specify the placement of an image with
respect to inline text.

The start attribute of <OL> tag is used when you want to start the numbering from a
different letter or number.

Answer the following questions.
What is the use of the <IMG> tag? What are its attributes?

<IMG> tag is used to insert image in HTML page.

It is an empty tag.

The attributes of <IMG> tag are src, height, width, align, alt, border.

What is the purpose of src and alt attributes of the <IMG> tag?
1. Src: This attribute is used to specify the URL or the path of the image to be

Differentiate between <OL> and <UL> tags.

displayed.

For eg. <IMG src= “flower.jpg”>

2. Alt: This attribute is used to specify an alternative text that a browser will display if
the image cannot be displayed. For eg. <IMG alt= “flowers image”>

OL tag
Ordered list is also called as numbered
list.
Ordered list is used when the list items
have a specific numerical order or
ranking.
An ordered list is enclosed within the
<OL> and the </OL> tags.

The default numbering style is 1,2,3,.......

And so on.

UL tag
Unordered list is also known as bulleted
list.
In unordered list, the list items do not
have a specific order.
An unordered list is enclosed within the
<UL> and the </UL> tags.
The default value of bulleted list is
‘disc’.
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What is the use of type attribute of the list tags?

This attribute specifies the type of numbering or bullet to be used for each list item.
For example:

For Bullets > <UL type= “disc”/ “circle”/ “square”>

For Numbering - <OL type= “A”/ “a”/ “i”’/ “I"/ “1”>

How can you create multilevel lists?

Ordered and unordered lists can be nested within each other to form multilevel list.
For Example:

<UL type = “square”>
<LI> Beaches

<OL type= “a”>

<LI> Goa

<LI> Andaman & Nicobar
</OL>

<LI> Hills

<UL type= “circle”>

<LI> Darjeeling
<LI>Gangtok

</UL>

</UL>

Write the HTML code for the following.
To display square bullets in an unordered list.

<UL type = “square”>

To start an ordered list with the number 3.
<OL type = “1” start=“3">

To insert an image ‘picture.gif’ on a webpage and centre align it in the browser’s
window.

<center>

<img src= “picture.gif”’>

</center>

To display the text ‘building image’ if the image ‘building.jpg’ cannot be displayed.

<img src= “building.jpg” alt= “building image” >

HOTS
Suggest a suitable solution for the given problems.

You have written the following code to insert an image in the centre of the webpage.
However, it is not giving the desired results. Identify the error and write the corrected
code.

<IMG src = “logo.jpg” align = “center” >
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Ans The correct code is:
<center>
<IMG src = “logo.jpg”™>
</center>

2 You wrote the code to insert an image on the webpage. However, the image is
occupying the entire webpage space. How can you make the image appear in a specific
size?

Ans. The height & width attribute of <img> tag is used to specify the height and width of the
image in pixels.
For example:
<IMG height=“200" width= “200" >

3 You want to display two images “picturel.jpg” and “picture2.jpg” as a bulleted list.
Write the code for the same.
Ans: <UL type = “circle”™>
<LI><IMG src= “picturel.jpg”™>
<LI><IMG src= “picture2.jpg™>
</UL>
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Chapter-1 Networking Concepts

Assessment Zone

Choose the correct answer.

1 What is the importance of a computer network?
a. It allows sharing of resources. b. It is an effective communication medium.
c. It lets users share files. d. All of the above.
Ans. d. All of the above.
2 A network that spans countries and continents is known as
a. LAN b. MAN c. WAN d. PAN
Ans. c¢. WAN
3. Adevice used to connect computers in a network is referred to as
a. afirewall b. CPU
c. HTTP d. aswitch
Ans. d.aswitch
4. Atopology in which every computer is connected to every other computer is called
a. Ring b. Mesh  c. Star d. Bus
Ans. b. Mesh topology
5. It transmits data in the form of light rather than electronic signals.
a. Coaxial cable b. Bluetooth
c. Optical fibre cable d. Twisted pair cable
Ans. c) Optical fibre cable

6. A computer network organised around a person for communication between devices such as
phones and personal digital assistants is called
a. PAN b. LAN c. MAN d. WAN

Ans. a) PAN
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7. A device used to connect two or more networks.
a. NIC b. MODEM c. Router d. None of these
Ans. c) Router

Fill in the blanks using the words given in the box.

1  Topology refers to the layout pattern in which the computers are connected to each other
in a network.

2. A MAN is formed when the computers are connected in a neighbourhood area.
3. AFirewall is used to prevent unauthorised access to a network.

4. Modem stands for modulator-demodulator.

5. Protocol is a set of rules used by computers on the network to communicate with each
other.
6.  Wi-Fi and Bluetooth technologies make use of radio waves.

7. Infrared waves are used for communication between a TV set and its remote control.
8.  TCP/IP protocol is used to send data in the form of packets on the internet.

9. InRing topology, each computer is connected to two other computers so as to form a
closed network.

10. A CAN is a computer network that connects two or more LANS but is not as large as a
MAN or WAN.

Answer the following questions.

1.  Define the term ‘computer network’. What are its advantages?

Ans. A computer network consists of two or more computers that are linked in order to share
resources such as printers, exchanges files and allow communication.

Some of the advantages of computer networks are:

1. Resource Sharing.
2. File Sharing and Remote Database Access.
3. Ease of Communication.

2.  State the types of computer networks based on the geographical area covered by them.

Ans. The following are the types of network based on geographical area covered or scale of the
network:
1. PAN (Personal Area Network)
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Ans.

AnSs.

Ans.

AnS.

Ans.

AnSs.

2. LAN (Local Area Network)
3. CAN (Campus Area Network)
4. MAN (Metropolitan Area Network)
5. WAN (Wide Area Network)
Write a note on twisted pair and coaxial cables.

Twisted Pair Cable:

1. It consists of a pair of insulated wires twisted together.

2. It comes in two varieties: Shielded Twisted Pair (STP) and unshielded Twisted Pair
Cable (UTP)
Coaxial Cable:

1. Coaxial cable is an electronic cable with a conductor at its centre.

2. The inner conductor is surrounded by a tabular insulating layer.

3. The insulating layer is surrounded by a conductive layer called the shield, which is
finally covered with a thin insulating layer on the outside.

Give the advantages of optical fibre cables.

1. It transmits data in the form of light rather than electronic signals.
2. It has the capability to carry data at a very high speed.
3. It can transmit the signals over much longer distances.

What is a bus topology?

1. In bus topology, all the computers are connected to a single cable called the bus.

2. The transmission of data from any computer travels through the length of the bus in
both the directions.

3. The advantage of the bus topology is that it is quite easy to set up.

How is hub different from a switch?

1. Inahub, when once computer sends data on the network, the hub simply forwards the
packets to all the other computers connected to it.
2. Unlike a hub, the switch sends the incoming data to the desired destination only.

Discuss some common threats to network security.
Some of the common threats are: Virus, Worm, Trojan Horse, and Data Theft.

What is a firewall?

A firewall is used to prevent unauthorised access to a computer network.
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A firewall examines each message and blocks those that do not meet the specified security
criteria.

0. How is microwave transmission different from radio wave transmission?

Ans. e Microwave communications are e Radio wave communications are
unidirectional. omnidirectional.
e They can be used for terrestrial e They are widely used for
communication or for satellite communication both indoors and
communication. outdoors.

Example: High towers with antennas in the ~ Example: Bluetooth/Wi-Fi technologies
city.
HOTS

A.  Explain how a packet of data travels from one computer to other over the internet. (omit)

B. A company has two offices in adjacent buildings. The computers in the two offices need
to be connected to one another for a very high speed connectivity.

1.  What cable should be used to connect the computers in these two offices?
Ans. Optical Fibre Cable

2. What type of network is formed when the computers in the two offices are connected to form
a network?
Ans. CAN
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